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This workbook has been developed for the Coventry workshop 

  

“Using and analysing WEMWBS to measure the impact of interventions in improving mental 

wellbeing”.1 

Who is this for? 

The workshop and workbook are for staff who are using the Warwick-Edinburgh Mental 

Wellbeing Scale (WEMWBS), or would like to, to evaluate the effectiveness of their projects or 

programmes in improving mental wellbeing. 

The purpose is to equip staff with the knowledge and skills to effectively collect and analyse data 

using the Warwick-Edinburgh Mental Wellbeing Measurement Scale (WEMWBS). 

Learning outcomes: 

At the end of the workshop participants will have the knowledge and tools to equip 

them to measure mental wellbeing as an outcome of their intervention, through: 

• Setting-up and administering the WEMWBS measurement tool with participants 

• Analysing the data and calculating a mean score 

• Interpreting the results to show impact 

It addresses Public Health competencies: 

KH8 Analysis of data on a small area basis and understanding of the limitations of the analysis 

KH26 The principles and methods of evaluation 

Further information on the WEMWBS and its use is available at 

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs 

                                                           
1 It is based on the workbook developed for  ChaMPs CPD and the WEMWBS practice-based user 

guide produced by Coventry City Council, NHS Coventry, and Warwick Medical School, and authored 

by Rebecca Johnson, Kate O’Hara, Frances Taggart, and Sarah Stewart-Brown, September 2012: 

Using WEMWBS to measure the impact of your work on mental wellbeing: A practice-based user 

guide. 

 

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs
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1.0 Introduction: mental wellbeing and WEMWBS 

1.1 Background 

Improved mental wellbeing is a key national outcome and a fundamental part of being a healthy and 

resilient individual. WEMWBS is one of the measures used for the ‘self-reported wellbeing’ indicator 

in the English Public Health Outcomes Framework. 

In order to achieve a consistent and comparable approach and to understand and improve best 

practice in Coventry, Coventry City Council and NHS Coventry recommend that the WEMWBS is 

used, where appropriate, to measure improvements in mental wellbeing. 

 

1.2 What is mental wellbeing? 

Mental wellbeing is about functioning well, for example having control and influence, a sense of 

meaning and purpose in life, a sense of belonging and connection and the capability to manage 

problems and grow learn and develop. . It is also about feeling good.  Mental wellbeing  is therefore 

central to parenting, educational attainment, employment & work productivity, community 

participation and cohesion, crime and safety. 

Mental wellbeing is also a key outcome for and a determinant of physical health, through for 

example: 

• Effectively managing long term conditions 

• Reducing obesity, heart disease and other illness 

• Making healthy life choices 

• Recovery from illness 

1.3 What is WEMWBS? 

The Warwick-Edinburgh Mental Well-being Scale (WEMWBS) is a validated measure of mental 

wellbeing that has been used nationally, regionally and locally. It is a 14-item questionnaire that 

produces a single score. See Appendix 1. It is self-completed by people aged 13+ to record 

‘statements about thoughts and feelings over the past two weeks’. 

1.4 Why use WEMWBS? 

The findings can be used to establish whether a specific population or group of people has low, 

average or high mental wellbeing and thus where to target investment for groups most in need.  It 

can be used to measure changes over time and is therefore good for evaluation of the effect of an 

intervention project or programme.   Having a control group one that has not been offered the 

intervention would 

strengthen any findings of the impact that the intervention has had on mental wellbeing, but may 

not be practical . 
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The Warwick-Edinburgh Mental Well-being Scale  
(WEMWBS) 

 
Below are some statements about feelings and thoughts. 

 
Please tick the box that best describes your experience of each over the last 2 weeks 

 

 

Warwick-Edinburgh Mental Well-Being Scale (WEMWBS) 
© NHS Health Scotland, University of Warwick and University of Edinburgh, 2006, all 

rights reserved.  

STATEMENTS 
None 
of the 
time 

Rarely 
Some 
of the 
time 

Often 
All of 

the time 

I’ve been feeling optimistic about the 
future  

1 2 3 4 5 

I’ve been feeling useful  1 2 3 4 5 

I’ve been feeling relaxed  1 2 3 4 5 

I’ve been feeling interested in other 
people  

1 2 3 4 5 

I’ve had energy to spare  1 2 3 4 5 

I’ve been dealing with problems well  1 2 3 4 5 

I’ve been thinking clearly  1 2 3 4 5 

I’ve been feeling good about myself  1 2 3 4 5 

I’ve been feeling close to other people  1 2 3 4 5 

I’ve been feeling confident  1 2 3 4 5 

I’ve been able to make up my own mind 
about things  

1 2 3 4 5 

I’ve been feeling loved  1 2 3 4 5 

I’ve been interested in new things  1 2 3 4 5 

I’ve been feeling cheerful  1 2 3 4 5 
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Q 1. Have a go at completing the WEMWBS survey yourself 

What did you think about this? How did it make you feel? 

 

 

 

 

 

 

Do you have any questions? 

 

 

 

 

 

Did all questions seem straightforward? 

 

 

 

See how your score compares with the population graphs shown below for Coventry and 

England as a whole. 
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1.5 Current population baseline 

Recent surveys have provided a population baseline for mental wellbeing in Coventry as well as 

nationally. The two are very similar. 

http://www.coventrypartnership.com/upload/public/documents/news/PIE%20GROUP/2012%20Cov

entry%20Wellbeing%20Report_FINAL_27%20JULY.PDF 

Coventry Household Survey 2012 

 

 

Health Survey for England 2011 
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This means that there is an expected score for Coventry population’s average that you can compare 

your intervention group with. You may want to consider the age and sex distribution of your group 

and how that compares with the survey age sex distribution since scores vary a bit with age and sex.  

See the Health Survey for England  

http://www.hscic.gov.uk/catalogue/PUB13218/HSE2012-Ch5-Wellbeing.pdf 

Understanding Society, the UK’s Household longitudinal study 2011 

https://www.understandingsociety.ac.uk/ 

 

1.6 Using the WEMWBS in interventions, projects or programmes to measure changes in wellbeing 

There are good examples of WEMWBS being used already with different intervention groups within 

Coventry as well as nationally. For example 

WEMWBS could be used to measure improvements in wellbeing within services and interventions 

such as: 

• Social prescribing 

• Health Trainers 

• Employment support 

• Parenting support 

• Workplace health 

• Community involvement and development projects 

• Volunteering 

• Self-care/condition management 

• Befriending 

Example: Wellbeing Mentors in Coventry Schools.  This was part of the Healthy Schools Project in 

eight secondary schools in Coventry over two years, 2010 – 2012.  The aim of the WBM role was to 

identify support for pupils who may have health related barriers to learning in school. Specific aims 

included: to build greater resilience in pupils by focusing on healthy lifestyle promotion; to mediate 

and ‘signpost’ pupils, and in some cases their families, to professionals and partner agencies 

depending on need; to identify pupils ‘at risk’ of low educational attainment earlier; and to be 

embedded within schools to better support pupils experiencing health related difficulties (e.g. 

physical, mental, emotional health problems, family problems).  

The WEMWBS questionnaire was administered at the beginning (T1), at six weeks at the end of the 

mentoring period (T2) and at follow up ten weeks after completion (T3).  The change in WEMWBS 

http://www.hscic.gov.uk/catalogue/PUB13218/HSE2012-Ch5-Wellbeing.pdf
https://www.understandingsociety.ac.uk/
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total scores in the group of pupils was calculated.  The table below shows the change in scores from 

T1 to T3. 

Change in WEMWBS scores between intervention time points 

Time-Points Number pupils Change in WEMWBS 
total mean score 

Standard 
deviation 

P-value* Significant 
Change? 

T3-T1 94 WEMWBS total 
mean score changed 
from 44.48 at T1 to 
55.62 at T3. This is 
11.15 point increase 
in score. 

10.9 P<.001 Significant 
positive 
change 

 

The T-test is a statistic based on both the difference in mean score between T1 and T3 and also the 

variation between the 93 people in the sample as a whole.  The P value is derived from the T-test 

and tells us how likely the change is to have occurred by chance.  A value for P of less than 0.05 is 

unlikely to be due to chance and is therefore considered significant. 

IMPORTANT 

WEMWBS is not designed to be an individual diagnostic tool.  By this, we mean that it should not be 

used to ‘diagnose’ a person’s poor mental wellbeing, but it may prove useful as a starting point for 

discussion about mental wellbeing, what it is and why it is desirable.  

If completing the WEMWBS, raises issues for individuals that they want to discuss with others, they 

can be advised to go and see their GP or the Improving Access to Psychological Therapies (IAPT) 

service. Other tools exist to support discussions about mental wellbeing with individuals and groups. 

E.g. Five or Ten ways to wellbeing, Fair deal for wellbeing discussion kit. See: 

www.champspublichealth.com paper on: Discussing mental wellbeing during brief interventions 

www.ourlife.org.uk discussion kit Fair Deal for Wellbeing 

If a participant is worried about their mental health and doesn’t want to see their GP or the IAPT 

service   they can contact local helplines or websites. Other resources include: 

Living Life to the Full – www.llttf.com 

NHS Choices – www.nhs.uk/LiveWell/mental-wellbeing 

 

  

http://www.llttf.com/
http://www.nhs.uk/LiveWell/mental-wellbeing
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2.0 How to use WEMWBS to measure mental wellbeing 

2.1 Gaining permission 

WEMWBS is free to use. HOWEVER, you must seek permission to use WEMWBS by completing an 

online registration form on the WEMWBS website: 

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/register/ 

The Reproduction copyrights for WEMWBS are as follows and must be presented on any copy of 

WEMWBS used : 

“Warwick-Edinburgh Mental Well-being Scale (WEMWBS) © NHS Health Scotland, 

University of Warwick and University of Edinburgh, 2006, all rights reserved”. 

If you produce any documents outlining your WEMWBS results (such as reports, presentations) you 

must also reference WEMWBS  as above. 

2.2 Planning 

Take time to consider what it is your project is aiming to achieve. The things you are measuring are 

important. WEMWBS data that you collect will show the impact of your project on participants’ 

mental wellbeing. 

 

 

 

 

 

 

 

 

 

 

 

 

2.3 Sample selection 

Q2. Imagine you were going to administer the Wellbeing Mentors in Coventry Schools project 

described above. 

What might you need to consider before starting using WEMWBS in this project?  

Use this space to write down your thoughts: 

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/register/
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The number of people you ask to complete WEMWBS will depend on the nature of your project but 

generally 30 people or more is best.  However people have done useful evaluations with fewer 

people than this.   

We have prepared some standard materials to help you with your evaluation and these are at the 

back of this workbook. There is an introductory statement that you may wish to use when you are 

presenting the evaluation to potential participants.  This can be adapted for the particular 

circumstances of the project.  Similarly the questionnaire contains basic information such as age and 

gender which is necessary for most projects but you may wish to include other things, depending on 

your project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.3 Timescales 

In order to identify the impact of a project, WEMWBS data must be collected at the start and end. 

If you have a long project, you might choose to also collect data mid-way through, to identify 

progress. If your project is discrete (has a clear start and end point) you may be able to easily identify 

when this information will be collected (for example, during the registration to a project, and at the 

final session). 

Example 

If you have a 12-week project, you could ask participants to complete the WEMWBS survey in week 

1, upon registration. You could then ask participants to complete the follow-up survey during their 

Q3. Imagine you are going to evaluate a walking programme designed to help people to lose 

weight, get fit and improve their mental wellbeing.   Discuss the project in your group.   

Are there any particular issues with this project you would need to consider? 

Are there any outcomes you would measure besides the WEMWBS questionnaire? 
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final session in week 12. Alternatively, if you know that a lot of people drop-out of your project from 

about the 8th week, you may wish to ask people to complete their follow-up WEMWBS after 8 

weeks to maximise your sample size. You may wish to also ask participants to complete WEMWBS at 

a mid-point, such as 6- weeks into the course. This will enable identification of early progress. 

But what if my project is open-ended… 

If your project is open-ended and does not have a structured start and finish, you may wish to 

recruit a selection of participants as they register. The timescale for the collection of follow-up data 

will be dependent on the nature of your project, but you could collect their follow-up data at 8-10 

weekly intervals, and/ or when they decide to leave (if sooner). If possible, you may also collect 

WEMWBS at a time after the project has finished to see if mental wellbeing levels are sustained 

beyond the life of the intervention. This will require some forethought because it may be difficult to 

contact people who have ‘dropped out’ or have finished the project some months before.  

2.4 REMEMBER 

WEMWBS asks people to reflect on each statement within the past 2 weeks, therefore it is 

important that there is a minimum 2 week gap between the before and after questionnaires. 

 

Issues to consider: 

How easy is it to contact participants, to implement the before and after surveys? 

Is it possible to conduct a follow-up WEMWBS within your project? 

See also Section 2 of the Coventry practice-based user guide. 

2.5 Completing WEMWBS 

WEMWBS is designed for participants to complete themselves either on paper or computer assisted. 

WEMWBS has not been tested for interviewer completion (with the interviewer reading the 

statements out and filling in the responses for them). This is therefore not recommended unless 

necessary for helping people with visual impairments or reading difficulties. Getting responses over 

the telephone is not ideal but is better than nothing. Telephone follow up responses should ideally 

be analyses separately and collection over the telephone may influence responses.  

Please maintain privacy when reading out statements. See the full user guide for more details 

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/userguide/ 

It is useful to be prepared and know what people completing the form might ask you about. 

 

 

  

 

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/userguide/
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2.6 Introducing WEMWBS to potential participants 

Before you collect any data, you need to explain WEMWBS to potential participants, and gather their 

consent to take part in the survey. 

WEMWBS can be described to potential participants as ‘statements about their thoughts and 

feelings in the past two weeks’. Explain that you would like to ask them about these statements 

before they start the project and then again at the end (you may also ask them at a mid-point) to 

follow the effects of this project. Explain that WEMWBS has been specifically designed and tested for 

measuring the impact of projects such as this one. 

Gaining consent to participate in evaluation 

It is important to invite participants to take part in the project evaluation. Participants should 

be made aware that WEMWBS is not part of the intervention/ service, that they do not have to 

complete the questionnaire if they don’t want to, and their decision will not affect the service 

offered to them.  You should ask people if they have any questions and be prepared to answer them. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Q 4. How might you check that people are happy to participate? 

 

 

 

 

What might be included in a consent form? 

 

 

 

 

See sample consent form Appendix 1 
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2.7 Are there any risks to participants? 

WEMWBS is an ideal tool to use, as it generates information regarding mental wellbeing in a timely 

and cost-effective manner. However, occasionally, reflection on the WEMWBS statements may 

generate distress. See page 6 of the Coventry practitioner user guide. 

For participants to recognise that their mental wellbeing is not good is not necessarily a bad thing. It 

can be the first step towards taking action to feel better. 

If this happens when you are evaluating your project you can provide information to the participant 

on where they can seek help with distress. It may be that it is appropriate for the participant to 

discuss any issues with the person collecting WEMWBS scores or it may be possible to for them to 

talk to another member of the project team. 

 The practitioner can use other tools, such as the Five Ways to Wellbeing, to discuss mental 

wellbeing with participants. See the 

ChaMPs brief guide on discussing mental wellbeing during brief interventions. 

http://www.champspublichealth.com/writedir/4349Discussing%20wellbeing%20during%20brief%20

interventions.pdf 

 

  

http://www.champspublichealth.com/writedir/4349Discussing%20wellbeing%20during%20brief%20interventions.pdf
http://www.champspublichealth.com/writedir/4349Discussing%20wellbeing%20during%20brief%20interventions.pdf
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Quick Checklist for setting up using WEMWBS 

Before you start using WEMWBS check that you have… 

 Understood WEMWBS is used to evaluate change in mental wellbeing as a direct result of a 

project intervention and that it is not a diagnostic tool. 

 Sought permission from University of Warwick 

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/register/ 

 Decided on time frame/interval – before, during, after; at start and eight weeks 

 The timeframe is at least two weeks apart 

 Decided on who to distribute to – whether there are enough participants 

 All participants are aged 13 years and older 

 Printed out all relevant document (including information sheets/consent forms and 

WEMWBS questionnaire sheets) 

 Information includes an explanation of the evaluation, that it is confidential and the decision 

to participate or not does not affect the service offered. 

 Ensured any potential risks, such as distress, disclosure of personal information, data 

protection issues etc are fully considered 

 Agreed and included any additional information to collect at the same time as 

WEMWBS, such as age, gender, ethnicity, employment status, change in physical activity or 

diet 

 Agreed how you will record the WEMWBS responses – on an Excel spreadsheet or statistical 

package such as SPSS. 

 Ensured the project team is fully aware of all aspects of the evaluation  and why these 

questionnaires are being used. All staff should be fully briefed on methods such as assigning 

identifiers and what to do with completed questionnaires. 

 Ensured you meet any information governance requirements of your organisation 

  

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/register/
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3.0 Collecting the data 

3.1 Assigning identifiers 

Each person completing a WEMWBS questionnaire will need to be assigned a unique identifying 

code so that their responses at each stage can be compared. This identifier can be an initial, a 

number or a code, but cannot be the individual’s full name. This identifier needs to be recorded so 

that any member of staff can refer to this at any stage of the evaluation. A good idea is to assign this 

participant code at registration, next to their name, and to store this electronically on a password 

protected file. This way you can check which code you have given to which participant when it 

comes to the follow-up survey/s. This information should be saved separately from where you save 

your WEMWBS data. You may need this identifier to match up your data if you want to analyse by 

any socio-demographic group that is not in the WEMWBS datasheet. 

The Coventry practitioner guide provides an example of tracking data: 

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/userguide/wem

wbs_practice_based_user_guide.pdf 

 

3.2 Additional information 

For each questionnaire, it is a good idea to collect some information so you can understand more 

about the individuals taking part in the research. The individual can complete this information at the 

same time as completing the WEMWBS questionnaire. This could for example, include demographic 

information such as age, sex and ethnicity, along with any notes relating to the individual but which 

are not identifiable, such as completed intervention at 8 weeks, dropped out at week 4 etc. See 

Appendix 1c. 

 

3.3 Storing data 

Once you receive completed questionnaires it is best to check them and to make notes on the front 

sheet if, for example, there are any missing sections and ensuring the unique identifying code is 

there. The paper questionnaires should be stored in a locked filing cabinet. Hard copies of names 

and corresponding participant codes should not be stored – this needs to be kept electronically on a 

password protected computer. Only members of the project team must access the files. 

  

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/userguide/wemwbs_practice_based_user_guide.pdf
http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/userguide/wemwbs_practice_based_user_guide.pdf
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4.0 Analysing and Interpreting the Data 

4.1 Missing data 

For the 14 item WEMWBS we recommend not reporting on any questionnaires where less than 11 

out 14 answers have been completed. If more than three are missing then do not include the 

questionnaire in analysis. For those questionnaires with 11, 12 or 13 questions, a weighted average 

can be used, so if 11 questions are answered, add up the answers, divide by 11 and multiply by 14.  

For 12 questions multiply by 14/12, for 13 answers multiply by 14/13.  The Excel worksheet supplied 

does this automatically. 

 

 

 

 

 

Number of 
questions 
answered 
 

WEMWBS 
Score (total for questions 
answered) 
 

Adjusted 
WEMWBS 
score 
 

11  36 45.82 

12 41  

13 41  

9 28  

14 45  

 

4.2 Inputting data 

It is good practice to record the data from the completed WEMWBS questionnaires as you receive 

them, or at the end of each stage once all have been submitted. The data can be entered onto an 

excel spreadsheet. 

A template worksheet has been prepared and can be downloaded from the Warwick WEMWBS 

website. 

 

Record data for each individual on a separate row: 

i. Unique identifier code – on both questionnaires 

ii. Date of completion of first (pre) questionnaire 

iii. Score of each question (1-5) from first questionnaire 

iv. Sum of scores (the worksheet calculates this automatically) 

Q. 5 

Try calculating the adjusted scores below. 

Answers in appendix 2 
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v. Date of completion of second (post) questionnaire 

vi. Score of each question (1-5) from second questionnaire 

vii. Sum of scores (the worksheet calculates this automatically) 

viii. Record any additional data you are collecting e.g. age 

The worksheet also does a check that the questionnaires were done 2 weeks apart. 

4.3 Analysing data 

You may be working with a team and a data analyst to help you understand the results. It will be 

between your project team and the data analyst to work together and put the WEMWBS results in 

the context of your project. Your worksheet should already have been set up to work out the 

WEMWEBS scores for each stage. You might want to do some additional analysis that is not in the 

worksheet such as by subgroup in your intervention. Remember that you can save more copies of 

the worksheet and put different data into it. 

i) Calculate the change 

For each entry in Q6 below, subtract the sum of scores 1 (first questionnaire WEMWBS T1) from the 

sum of scores 2 (second questionnaire WEMWBS T2). If the first sum is greater this will give a minus 

(-) and denotes a decrease in wellbeing. The worksheet includes a column on whether the change is 

positive i.e. resulted in an increase in wellbeing; and meaningful, i.e. greater than 3. 

ii) Calculate the mean change 

Add together all the change scores from i) above. Divide this by the total number of participants*. 

This is the mean change in wellbeing from the beginning of the intervention to the end. 

 

 

 

 

 

 

 

 

 

 

 

Q6. Quick calculation: 

For the group of 10 participants below: 

What is the mean WEMWBS of participants before the course? 

What is the mean WEMWBS of participants after the course? 

What is the mean change in WEMWBS? 

R1 pre score 42 post score 42 

R2 pre score 28 post score 38 

R3 pre score 24 post score 36 

R4 pre score 20 post score 24 

R5 pre score 44 post score 42 

R6 pre score 38 post score 44 

R7 pre score 34 post score 41 

R8 pre score 46 post score 50 

R9 pre score 40 post score 44 

R10 pre score 44 post score 52 
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4.4 Measuring the impact of your work 

Meaningful increases in WEMWBS: 

A statistically significant result means that the  change over time is unlikely to have happened by 

chance. With large numbers of people a very small difference may turn out to be statistically 

significant and this small difference may not be considered meaningful.  Any improvement of more 

than three points is likely to be meaningful. An improvement of eight points is unequivocally 

meaningful. The total number of participants and completed questionnaires needs to be clear in the 

interpretation of your results. If you have more questionniares at the beginning than the end – all 

the questionnaires at the beginning can be used to measure the wellbeing of the group you included 

in the project or programme but only those questionnaires for which you have matching at a later 

time can be used to calculate change.  

 

 

 

 

 

 

 

 

4.5 Statistical significance 

Whether a difference is statistically significant or will depend on the number of participants 

completing WEMWBS questionnaires, the average change, and the amount of variation in scores. So 

it is not possible to say for certain what sample size will produce statistically significant results, but 

as a general minimum at least 30 before and after values will be needed for statistical significance. 

That is not to say that you should not use WEMWBS to evaluate an intervention with less than 30 

clients as you may still get useful results even if they are not statistically significant. 

In terms of statistical tests, results from WEMWBS can be compared several ways. If you have before 

and after data for more than around 100 clients, you can use a paired sample t test – this assumes 

that your data is normally distributed (i.e. has a bell shaped distribution), if you are not sure if your 

data is normally distributed you get a rough idea by looking at your data in a histogram or can do a 

test of normality in SPSS. 

  

Q7. How would you describe the change in wellbeing from the results in Q6? 
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See Appendix 3 for more information on statistical tests. 

5.0 Reporting on your work 

It is useful to document details about your intervention and its impact on project participants. 

Alongside the data you may want to talk about the mechanism through which you think clients 

mental wellbeing has increased and include additional interviews or information 

from clients or project staff to understand how smoothly the project has been running, and what 

their perceptions are of the project itself. 

The methodology behind your research involving WEMWBS will need to be included in a final report, 

which explains the stages to your research. For example: 

 

• Recruitment and actual numbers including details of those who may have dropped out or number 

of uncompleted questionnaires 

• WEMWBS questionnaire stages – before, during or after 

• Explain any additional research you may have conducted, such as satisfaction surveys or interviews 

with clients/staff. 

• Include reference to local, regional or national baseline scores 

5.1 Communicating your results 

It is useful to communicate your results in a final paper/ report, even if there was no positive 

change: 

• To all members of your team. 

• To your clients/ project participants - it is helpful for them to hear the outcome of the research, 

and to also to understand the findings – the impact that the project has on mental health and 

wellbeing. 

• To Coventry City Council  to support dissemination of best practice locally 

• In agreement with the permission to use, to the University of Warwick 

(frances.taggart@warwick.ac.uk or Sarah.Stewart-Brown@warwick.ac.uk). 

• Also consider publishing your work in a journal e.g. Journal of Public Mental Health 

http://www.emeraldinsight.com/products/journals/author_guidelines.htm?id=jpmh&PH 

PSESSID=6v98ts1n7in4tildkk5dcucjd6 

Useful links 

WEMWBS user guides 

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/userguide/ 

http://www2.warwick.ac.uk/fac/med/research/platform/wemwbs/researchers/userguide/
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NW report providing local baselines - Deacon et al (2010) The North West Mental Wellbeing Survey 

2009, NWPHO 

http://www.nwph.net/nwpho/publications/NorthWestMentalWellbeing%20SurveySummary.pdf 

Appendix 1  

Sample Materials 

Appendix 1a:  Introducing the WEMWBS questionnaire to participants 

Say: “To help us understand if our activity/project/service has any influence on your wellbeing, we 

would like you to answer some questions now and again at the end of the activity/project/service”      

If asked: 

Q. “What do you mean by wellbeing?” 

A. “When we are talking about wellbeing we mean feeling good – for example feeling happy and 

contented with your life; and doing well – for example do you feel you are growing and developing, 

are your relationships going well, do you feel your life has purpose and can you make positive 

changes  to your life?” 

 

Ask each participant to complete the consent form if they agree to take part in the evaluation. You 

need to tell participants that their answers will remain anonymous in any reports about the 

activity/project/service and that the forms they fill in will be kept securely and confidential.    

 

NB in managing WEMWBS information you should follow the information governance arrangements 

for your organisation.  

 

Say: “When you answer the questions we would like you to think about your wellbeing, how you 

have been feeling, thinking and functioning over the last 2 weeks. 

Please read each statement describing different aspects of wellbeing. Tick the box that best 

describes your experience of each one.  When choosing your answer, think not just about how you 

are feeling now but what your experience has been over the last 2 weeks. 

 

NB Write the unique Code Number you have given the participant both on the questionnaire and on 

the consent form. Also write the date the WEMWBS was completed. This will allow you to link the 

questionnaire completed at the end with the one completed at the beginning and to tell which is 

which. 

  

http://www.nwph.net/nwpho/publications/NorthWestMentalWellbeing%20SurveySummary.pdf
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Appendix 1b:  Consent Form 

Warwick-Edinburgh Mental Wellbeing Scale questionnaire 

To help us understand if attending our activity/project/service has made any changes to 

people’s wellbeing, we would like you to answer some questions about your wellbeing.  We 

will ask these questions now and again at the end of the activity/project/service.    

 

The questionnaire will take about 10 minutes to complete.   

We would be very grateful if you would help us with this evaluation. 

 
 
Respondent Code Number: ……………… 

 

CONSENT FORM 
 

Title of Project: ………………………………………………………………………………………………………………………………….. 
 
     

  Please put your 
initials in these 
boxes. 

1. I confirm that I understand what the study is about and have had the opportunity to ask 

questions. 

 

2. I understand that my participation is voluntary and that I am free to withdraw at any time, 

without giving any reason. 

 

   

  

5. I agree to take part in this evaluation. 

    

 

 

 
________________________ ________________ ____________________ 
Name of Participant Signature Date 
 
 
 
_______________________ ________________ ____________________ 
Name of Person taking consent Signature Date 
 

 
 
 
 
Please keep one copy of this form and give the second copy to the researcher. 
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Appendix 1c:  Questionnaire 

Thank you for agreeing to take part.   

 

This questionnaire is about mental well-being.  It is confidential.  We are really interested in 

your honest answers to the questions. 

How to answer the questions 

Most of the questions can be answered by putting a tick    in the box that applies to you. 

If it is difficult to choose, put a tick in the box that is most true for you at the time.   

Sometimes you will be asked to circle an answer or write an answer.  Please write as clearly 

as possible. 

First some questions about you 

Q1 What is your gender?  Man    

 Tick one box   Woman  

 

Q2 What is your age in years?     

 Please write your age in the boxes   years 

   

Q3 In the past few weeks were you any of the following? 

Tick one box  

 Full time education 

 Paid work full time 

 Paid work part time  

 Self employed 

 Out of work, registered unemployed and 

actively seeking work 

 Out of work, registered unemployed but 

not actively seeking work 
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 Permanently sick/disabled 

 Not working for domestic reasons 

 Retired 

 None of the above - please  

specify…………………………… 

 

 

Q 4  

To which of the following groups do you consider you belong? 

  White –British 

  White – Other 

  Asian Bangladesh 

  Asian India 

  Asian Pakistan 

  Chinese 

  Black African 

 Black Caribbean 

  Mixed 

  Don’t know  

   Other 

   

Any other ethnic group (please describe)…………………………… 
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Below are some statements about feelings and thoughts. 

Please tick (√) the box that best describes your experience of each over the last 2 weeks 

 

This is the end of the questionnaire 

Please check that you have completed all the questions. Thank you! 

  

STATEMENTS 

None 

of the 

time 

Rarely 

Some 

of the 

time 

Often 
All of the 

time 

I’ve been feeling optimistic about the future  1 2 3 4 5 

I’ve been feeling useful  1 2 3 4 5 

I’ve been feeling relaxed  1 2 3 4 5 

I’ve been feeling interested in other people  1 2 3 4 5 

I’ve had energy to spare  1 2 3 4 5 

I’ve been dealing with problems well  1 2 3 4 5 

I’ve been thinking clearly  1 2 3 4 5 

I’ve been feeling good about myself  1 2 3 4 5 

I’ve been feeling close to other people  1 2 3 4 5 

I’ve been feeling confident  1 2 3 4 5 

I’ve been able to make up my own mind about 

things  1 2 3 4 5 

I’ve been feeling loved  1 2 3 4 5 

I’ve been interested in new things  1 2 3 4 5 

I’ve been feeling cheerful  1 2 3 4 5 
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Appendix 2: 

Q2 suggested answers: 

• Is there a project team in place to collect the information? 

• Do the project team understand what mental wellbeing is and why it is important for 

health? 

• Do the project team understand what WEMWBS is and how it is used? 

• Do the project team fully understand the aims and objectives of the project? 

• Timescales (is the project open-ended, or does it have a clear start and end point?) Is it 

possible to complete a follow-up survey? 

• How big is the project (how many people attend/are part of it)? 

• Is there a structure in place for collecting, recording and managing WEMWBS data? 

• Do team members know how to track individuals over time (to enable collection of before 

and after WEMWBS scores, to identify change)? 

In fact pupils were referred to wellbeing mentors by teachers and mentoring was for one session a 

week for six weeks. The intervention was delivered by mentors via one on one mentoring sessions 

over 6 weeks at one session per week. All mentors were trained by the Local Authority before 

commencing their role in schools and participated in on-going regular meetings with a Wellbeing 

Mentors Project Manager where new training was conducted and progress reviewed.  

In an introductory meeting Mentors were asked to evaluate the mental wellbeing of their pupils 

using WEMWBS. In this meeting general and specific aspects of WEMWBS were discussed. 

Q3 suggested answers: 

Answers to question 2 above also apply to this or any project.   Differences are that this project has a 

more varied group of people attending in age and recruitment and follow up may be more varied.  

Most people will probably be self-referred and recruitment could be from a variety of sources, e.g. 

advertising in community centres, mother and toddler groups, local shops or the library. You may 

wish to have other outcome measures on the questionnaire and possibly ask people for phone 

numbers or other contact details to follow up. 

Q 4 suggested answers: 

Consenting process: Use form similar to Appendix 1b 

• Give clients information about the WEMWBS and explain how the information they provide will be 

used 

• Assurance that responses will remain anonymous when project results are reported 

• All WEMWBS forms will be kept secure and confidential 

• If the information is stored electronically, it will be kept on a password protected computer, and 

only the project team will have access to this. 
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Q 5 answers: 

Number of 
questions 
answered 
 

WEMWBS 
Score 
 

Adjusted 
WEMWBS 
score 
 

11  36 45.82 

12 41 47.83 

13 41 44.15 

9 28 Do not score 

14 45 45 

 

Q6 Answers: 

 

Before  After Change 

42 42 0 

28 38 10 

24 36 12 

20 24 4 

44 42 -2 

38 44 6 

34 41 7 

46 50 4 

40 44 4 

44 52 8 

Mean change 5.3 
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Appendix 3: Statistical tests 

Wilcoxon Signed Rank Test 

The WEMWBS workbook you will get automatically does a Wilcoxon signed rank test, this is 

appropriate where you have a small sample or data is not normally distributed. With a larger sample 

the results of this test are similar to the results you would get with a paired sample t test, so it is fine 

to use this even if you have a bigger sample. 

Doing a paired sample t-test in Excel 

You can do a paired sample t test using the ‘analysis toolpak’ [sic] add-in in Excel, this is a 

free add-in that comes with Excel. You do not need a disk or admin rights to install it. 

Excel 2003 

1. On the Tools menu, click Add-Ins. 

2. In the Add-Ins available box, select the check box next to Analysis Toolpak, and then click OK. 

Tip If Analysis Toolpak is not listed, click Browse to locate it. 

3. If you see a message that tells you the Analysis Toolpak is not currently installed on your 

computer, click Yes to install it. 

4. Click Tools on the menu bar. When you load the Analysis Toolpak, the Data Analysis command is 

added to the Tools menu. 

Excel 2007 

1. Click the Microsoft Office Button , and then click Excel Options. 

2. Click Add-Ins, and then in the Manage box, select Excel Add-ins. 

3. Click Go. 

4. In the Add-Ins available box, select the Analysis ToolPak check box, and then click OK. 

o Tip If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to locate it. 

o If you get prompted that the Analysis ToolPak is not currently installed on your computer, click Yes 

to install it. 

5. After you load the Analysis ToolPak, the Data Analysis command is available in the Analysis group 

on the Data tab. 

Excel 2010 

To confirm whether you already have the Analysis Toolpak installed, open the Data tab on the Excel 

ribbon. If the Analysis Toolpak is installed, you should see a Data Analysis button on the Ribbon, like 

the one shown here. If the Analysis Toolpak is not installed, go to the File tab and select Options in 
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the left column. In the Excel Options Window, select the Add-Ins category on the left. Near the 

bottom of this window, you see Excel Add-ins already selected in a drop-down menu labelled 

Manage.  Click the Go button next to this drop-down. The Add-Ins dialog will open. Here, you can 

select the check box next to Analysis Toolpak (and any other add-ins you want to install). 

Click OK. 

Once you have done this, on the data tab on the Excel ribbon you will have a button that says ‘Data 

Analysis’. 

If you click on ‘Data analysis’ you can do a paired samples t test, scroll down to ‘t test: paired 

samples for two means’. You will need your before and after WEMWBS totals data to be arranged in 

columns. then select your ‘before’ or baseline WEMWBS data as variable 1, and ‘after’ WEMWBS 

data as variable 2, and if you have selected the column titles then click the box that says ‘labels’, 

then click ‘ok’. 

Interpreting a paired sample t test 

The t test will give you an output in a new worksheet which will look something like this (the 

comments column has been added here to tell you more about what each value means): 

 

 Baseline WEMWBS  
 

12 week WEMWBS Comments 

Mean 49.47008547  51.21937322 These are the 
averages for the two 
groups. 
 

Variance 112.912674  
 

104.2003093 Variance is the 
standard 
deviation (SD) 
squared, 
so if you want to 
calculate SD, put in 
=SQRT(then click on 
these cells) 
 

Observations 351 351 This is how many 
people there were 
before and after.  
 

Pearson Correlation  0.628192431  This is the correlation 
between people’s 
before 
and after scores (it will 
be between 0 and 1 
where 1 is a perfect 
correlation, 0 is no 
correlation) 
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P(T<=t) two-tail  0.000307741  This is the significance 
level. Anything less 
than 0.05 can be said 
to be significant at the 
95% level. 
 

 

 

If you have data for more than two time points, say baseline, 12 weeks and six months, you can do 

more than one paired sample t-test to see if there has been a significant change between baseline 

and 12 weeks, 12 weeks and six months, and baseline and six months. 


